# 1. Table of contents

**INSTRUCTIONS - Delete this explanatory**

2

## Formatting

2

- Marking headings
- Normal Text
- Tables

3

## Header - Footer - Front page

3

- Front Page
- Header and Footer
- Cover Image

3

## Versioning

4

**END OF INSTRUCTIONS - Delete this explanatory**

4

## 1. Table of contents

4

## About this document

6

- Documentation version history
- Legend

6

## Warranty information

6

- Calibration
- Support
- Service/repair
- Restricted Rights
- Printing History
- Copyright
- Trademarks

7

## Safety instructions

8

- Safety symbols in the manual
- General Safety Instructions
  - Environmental Considerations
  - Product End-of-Life Handling
  - System and Components Recycling
  - General safety and hazard warnings for all Dewesoft systems

9
1. Introduction

1.1. FRF module

The DEWESoft FRF module is used for analysis of e.g. mechanical structures or electrical systems to determine the transfer characteristic (amplitude and phase) over a certain frequency range.

With the small, handy form factor of the DEWESoft instruments (DEWE-43, SIRIUSi) it is also a smart portable solution for technical consultants coping with failure detection. The FRF module is included in the DSA package (along with other modules e.g. Order Tracking, Torsional vibration, ...).

Let's assume there is a mechanical structure to be analyzed. Where are the resonances? Which frequencies can be problematic and should be avoided? How to measure that and what about the quality of the measurement?

Probably the easiest way is exciting the structure using a modal hammer (force input) and acceleration sensors for the measurement of the response (acceleration output). At first the structure is graphically defined in the geometry editor. Then the points for excitation and response are selected. The test person knocks on the test points while the software collects the data. Next to extracting phase and amplitude, in Analyse mode it is possible to animate the structure for the frequencies of interest. The coherence acts as a measure for the quality. The modal circle provides higher frequency precision and the damping factor.

For more advanced analysis the data can be exported to several file formats, important is the widely used UFF to read data in e.g. MEScope.

1.2. LTI systems

At first we have to assume that the methods described here apply to LTI (linear, time-invariant) systems or systems which come close to that. LTI systems, from applied mathematics, which appear in a lot of technical areas, have following characteristics:

- Linearity: the relationship between input and output is a linear map (scaled and summed functions at the input will also exist at the output, but with different scaling factors)
- Time-invariant: whether an input is applied to the system now or any time later, it will be identical

Furthermore, the fundamental giving of evidence in LTI theory is that the system can be characterized entirely by a single function called the system's impulse response. The output of the system is a convolution of the input to the system with the system's impulse response.

1.3. Frequency response function

Transfer functions are widely used in the analysis of systems, the main types are

- mechanical → excite the structure with a modal hammer or shaker (measure force), measure response with accelerometers (acceleration)
- electrical → apply a voltage to the circuit on the input, measure back the voltage on the output
In mechanical structures for example, when the transfer characteristic is known, this will show dangerous resonances. The frequency range, where the stress to the material is too high, has to be avoided, e.g. by specifying a limited operating range. The simplified process works like that: an input signal is applied to the system and the output signal is measured. The division of response to excitation basically gives the transfer function.

\[ H(f) = \frac{Y(f)}{X(f)} \]

In time-domain this is described in the following way:

In time-domain this is described in the following way:

\[ x(t) \rightarrow h(t) \rightarrow y(t) = h(t) * x(t) \]

Laplace transformation leads to the result in frequency domain:

\[ X(f) \rightarrow H(f) \rightarrow Y(f) = H(f) \cdot X(f) \]

DEWESoft utilizes the widely used \( H_1(f) \) calculation method, which is applied, when the output is expected to be noisy compared to the input.

\[ H_1(f) = \frac{\text{Cross Spectral Density of the Input and Output}}{\text{Auto Spectral Density of the Input}} \]

1.4. System overview

In most of the cases acceleration sensors, microphones, modal hammers or other force transducers are used for analog input. If they are e.g. voltage or ICP type, they are connected to the SIRIUS ACC amplifier, or DEWE-43 with MSIACC adapter. When analog output is needed (shaker), the AO8 option (8 channels BNC on rear side of SIRIUS instrument) provides a full-grown arbitrary function generator.
1.5. Enabling FRF module

Like many additional mathematics modules also “Modal Test (FRF, NMT)” is an option to the standard DEWESoft package and needs to be enabled in the Hardware setup: Enter <Settings> <Hardware Setup> and then <Math>.
Usually this must not be done manually, since the license is already stored on your Dewesoft instrument. Just click on the “Auto Detect” button and all options will be detected and enabled automatically.

1.6 Adding FRF module

In the next step we add one new module with the + button:

The description of the channel setup and the parameters is split into chapters 3.1 Triggered and 3.2 Free-run (sweep) on the following pages.

2. Setup / Operation modes

Depending on the application DEWESoft offers basically two different types of setup:
MODAL TEST AND ANALYSIS
SOLUTION USER MANUAL

- Triggered: For excitation an impulse is used (=wide frequency spectrum), e.g. modal hammer; easy to set up
- Free-run: The structure is excited e.g. with a shaker (or the engine rpm is varied), which sweeps through the frequencies (e.g. 10...1000 Hz)

As the channel setup is different, both setup types will be explained separately, along with practical examples.

2.1. Triggered

The easiest test consists of the modal hammer, which is used for exciting the structure with a short impulse (= wide frequency spectrum) and an acceleration sensor measuring the response. The hammer has a force sensor integrated in the tip, the tip ends are interchangeable. For bigger structures there are big hammers available with more mass to generate a distinct amplitude.

HINT: Please keep in mind that a hard tip generates a wider excitation spectrum, therefore you will get a better result (coherence) for the higher frequencies.

The two pictures below show the comparison. The scopes on top show time-domain, FFTs below show frequency domain (same scaling).
hard tip (low damping)                      soft tip (high damping)

On the other side, with a hard tip double-hits appear more frequently.

When you have set the calculation type to “Triggered (FRF)”, the setup looks like shown below.

On the left side specify the excitation (modal hammer), on the right side the response(s) (acceleration sensor(s)). For the following examples we named the two analog channels “exc” and “resp”.

Let’s do a short measurement to explain all the parameters. The structure is hit once and the signals are measured.
The hammer signal (upper, blue line) shows a clean shock impact with about 2500 N peak and high damping, while the response (lower, red line) starts ringing and smoothly fades out.

**Trigger level**

The FRF module needs a start criteria in triggered mode, therefore we specify a trigger level of e.g. 2000 N. Each time the input signal overshoots the trigger level, the FRF calculation (FFT window) will start.

![Trigger level settings](image)

**Double hit level**

However, when the input signal shows multiple impulses after one hit (so called “double hit”), DEWESoft can identify this if you specify a double hit level. When the signal crosses the double-hit-level shortly after the trigger event, you will get a warning message and can repeat this point.

![Double hit level settings](image)

**Overload level**

You can also enable that a warning will be displayed, if the hammer impact is exceeding a certain overload level (when the hit was too strong).
Now that we defined the trigger condition, we should ensure that the FRF calculation covers our whole signal to get a good result.

Window length Let's assume the sample rate of our example is 10 000 Hz and we have adjusted 8192 lines in the FRF setup.

According to Nyquist we can only measure up to half of the sample rate (5000 Hz), or the other way round, we need at least 2 samples per frequency line. So, our frequency resolution is:

\[ Df = \frac{10 000 \text{ Hz}}{8192 \text{ lines} \times 2} = 0,61 \text{ Hz}. \]

The whole FFT window calculation time (window length) is

\[ t = \frac{1}{Df} = \frac{1}{0,61} \approx 1,638 \text{ s}. \]

To see the section which is used for FRF calculation, add a 2D graph...
... then add the two channels "exc/Data History" and "resp/Data History".

Below you see the cut out data section of excitation and response signal, which covers pretty much the whole signal. Note, that the x-axis is scaled in samples (from -819 to 15565, which gives total 16 384 samples). 16 384 samples * (1/10 000 Hz) = 1.63 s.

Pretrigger

The pretrigger time is set to default by 5%. From the screenshot above you can see that 5% of 16 384 samples is 819 samples, which equals $t_{\text{pre}} = 819 \times (1/10 000 \text{ Hz}) = 81.9 \text{ ms}$. At sample 0 the trigger occurs.
Excitation window length

You can separately adjust the window length of excitation and response (it’s like cutting out the interesting segments of the graph above) in order to reduce the influence of noise appearing after the event of interest.

The “excitation window length” setting is valid for the excitation signal (modal hammer hit). Per default 100% is selected, all of the acquired data will be taken for calculation (all 16 384 samples in our example, the whole shown range).

The excitation FFT is of rectangular window type.

In our case the damping is very high (signal fades out quickly), therefore we can select a smaller portion of the signal, e.g. 10% (usually you would define a noise level first to determine it).

The rest of the signal will be cut out completely.

Response window decay

The response FFT is of exponential window type. When the response signal is fading out slowly (low damping), the user can specify a certain time after which the signal is faded to zero (exponential decay function). This helps to reduce noise at low amplitudes and shortens the measurement time. The draft below gives a rough idea about the damping.
Averaging of hits

The result can be improved by averaging the excitation and response spectra over a number of impacts. Therefore the first e.g. 5 hits will be recognized and taken into calculation, then you move on to the next point.

After explaining all parameters, we will now look at the different operation modes.
2.1.1. Triggered, 1 point

When all acceleration sensors are mounted, the structure is excited in one point by the modal hammer (average over a number of hits can also be done of course).
2.1.2. Triggered, roving hammer 1 Exc, 1 Resp

In this operation mode there is one acceleration sensor mounted on a fixed position on the structure. The modal hammer is moving through the points (e.g. doing 5 hits in each point, which are averaged).

This is the easiest test and requires only one hammer and one sensor.
2.1.3. Triggered, roving acceleration sensor

The hammer is always exciting the structure at the same position. Now the acceleration sensor is moved to different positions. The disadvantage of this setup is that the mass of the acceleration sensor changes the structure differently in every point, therefore influences the measurement (this effect is called “mass loading”). Also between each measurement the sensor has to be mounted again, which results in a lot of work.

2.2. Free-run (sweep)

When doing a frequency sweep and measuring the responses, you have the advantage that the coherence will be much better over the whole frequency range compared with a triggered setup. Of course you are facing a more extensive setup in terms of hardware, you’ll probably need a shaker (and a shaker controller, which keeps the amplitude constant over the frequency range).

The ODS (operational deflection shapes) is a very special form of FRF, using only accelerometers, please see page 22, chapter 3.2.3 ODS.
The channel setup of a typical free-run FRF is shown below.

The FFT windowing section is similar to triggered FRF, therefore please refer to the window length section on page 9, chapter 3.1 Triggered. You should ensure that the sweep is slow enough, because the FFT needs some time for calculation (number of lines, resolution).

Again, on the left we have the excitation and on the right side response channels.

If you enable the “Use function generator” checkbox, the FGEN settings Waveform, Start freq and Stop freq and the "AO channel" column in the excitation section will also be visible. These settings are the same as in the Analog out section (function generator).
Furthermore you can adjust the sweep time and amplitude/phase settings, if you enter the Setup of the according channel (AO 1 in our example). On the right side you can tick the checkbox “Show info channels”, e.g. seeing the current frequency during sweep is very helpful.

When you switch to Measure mode or press the Store button, the sweep will start.

In comparison with the triggered measurement our excitation(s) and response(s) will in most of the cases consist now of sine waves, with distinct amplitude and phase shift.

When using a sine sweep, as the sweep moves through the frequencies, the bode plots will be updated. Putting the “AO/Freq” channel on a separate display is a good way to show the current frequency.
The picture above shows two 2D graph instruments with transfer functions 2-1 and 3-1 (amplitude on top and the phase below) during a sweep. The left side is already calculated, while the right side is ongoing.

Now after all parameters have been explained, we will take a look at the different operation modes.

2.2.1. Free-run (shaker externally controlled)
The usual application for the free-run option is on a shaker. If the shaker is externally controlled, we can measure back the excitation signal (with a force sensor) and use it as reference.

Of course it would also be possible to use an engine instead of the shaker, and analyze the transfer functions during runup or coastdown.

2.2.2. Free run, FGEN, shaker

If we tick „Use function generator“, the FRF module accesses the FGEN section (requires Analog output option on Dewesoft instrument (AO)). It generates now e.g. a sine sweep from 10 to 1000 Hz. The shaker controller guarantees a defined amplitude over all frequencies. With the force sensor we measure back the excitation force.
Please consider that DEWESoft will not do the shaker control (control loop for amplitude), because of speed limitations. Practically a shaker control device ("shaker control" box in above picture) will be used in between.

2.2.3. ODS

In ODS analysis (= operational deflection shapes) the structure is only excited by the machine, like in real operation, whenever it is not possible to vary the excitation frequency. There are only accelerometers used.

Inside DEWESoft FRF module one of the acceleration sensors has to be defined as excitation (this one is the reference, you’ll get the best result when mounting it as close as possible to the vibration source; this will be normalized to 1), the others as response. Animation can be displayed as usual, but only makes sense in areas with good coherence.
3. Measurement and visualisation

3.1. Auto-generated displays

For an easier start DEWESoft offers auto-generated displays, which already come with the most often used instruments and an arrangement that makes sense for the according type of application.

With the FRF option and 1 module added, usually when switching to measure mode, there should already appear a screen with a small toothed wheel, called “Modal Test”.

If that is not the case, please go to Settings → Project setup... → Displays → and enable the “Automatically generate displays” checkbox. Then add a new FRF module. - With triggered setup (modal hammer), the screen should look like this:
The excitation and response sections each consist of two 2D graph instruments (scope and FFT) showing array data of hammer (red) and accelerometer signal (blue). The Info channel will show the current point or events such as doublehit. The Control buttons are used for going from one point to the next, or cancelling and repeating a point if the result was not satisfying. The OVL display shows if the impact or response signals are too high, exceeding the physical input range of the amplifier. The FRF Geometry is already animated in the current point during measurement. Two further 2D graphs on the right side show transfer function and coherence.

All these instruments / parameters are described on the following pages.

3.2. FRF info channels

There are additional channels provided by the FRF module, which give status information during the measurement. To display them, please add an indicator lamp in design mode:
Then set it to “Discrete display” mode (picture below, left).

The channels “Info” and “OVLChannel” can be assigned to it. OVLChannel will only be displayed if the according option has been enabled first (see also page 9, chapter 3.1 Triggered).

### 3.3. FRF control channels

- During triggered measurement, after one point is finished, you can continue by pressing the “Next point” button.
- If you are unsatisfied with the last hit, you can cancel it by using “Reject last”.
- If all hits for the whole point are incorrect, e.g. if you hit on a point with a wrong number, with “Reset point” you can delete all the hits done for the current point at once.

All the actions are done using “control channels” in DEWESoft. These can be modified during measurement. To change it manually, you need to pick the “input control display” from the instrument toolbar. Set it to the Control Channel and Push button. Channels “Reject last”, “Next point” and “Reset point” can now be assigned from the channel list on the right.

When you exit the design mode, you are able to press the buttons.
3.4. Geometry editor

In DEWESoft you can quickly draw simple structures, as well as import more complex ones. A Cartesian and cylindrical coordinate system is supported, which is great for drawing circular objects.

**IMPORTANT:** The Index numbers defined in the channel setup before are used as Point numbers in the geometry for animation.

In Design mode we add the “FRF Geometry” instrument. Then you can either load a UNV (universal file format) geometry file, or create your own.
3.4.1. Importing a structure

There are two ways of importing a UNV / UFF (universal file format) geometry of other software (e.g. MEScope or Femap) into DEWESoft. Of course you can also import geometry drawn in DEWESoft FRF Editor before. We support the newer “2411” format, if you experience troubles, please contact our support for the older plugin version supporting the outdated “15” format.

From the properties of the FRF geometry instrument on the left select “Load UNV”, or go to the Editor and do it there.

3.4.2. Drawing a structure

We will now use the editor to create a simple quadratic shape.
Cartesian Coordinates

At first you can choose between a Cartesian or Cylindrical coordinate system (see the two buttons below). Cartesian is default, so just add points with the “+” button, then enter coordinates. Keep in mind that the excitation direction was defined in FRF channel setup before (in our examples Z+), therefore Z is up, the hammer hits from top down.

You can define nodes (=points), then add trace lines between them by selecting from the pop-up...
... and use Triangles or Quads to optimize visualisation. Then save the structure.

Cylindrical Coordinates

And here is an example of how to create a cylindrical structure using the cylindrical coordinate system. You have to specify the Center point CS, radius R, angle theta T, and height Z.
Cartesian and cylindrical CS can be combined in one geometry.

4. Analyse and export

4.1. Transfer function

For the following explanation of parameters a triggered FRF was done on a snowboard structure. All 39 excitation points were sequentially hit by the modal hammer and related to 1 accelerometer placed in the center.

Only 1 hammer and 1 sensor was used! (please refer to page Error: Reference source not found, chapter Error: Reference source not found Error: Reference source not found if using multiple excitations/shakers).

From the channel list on the right side, we see that each point (#1, #2, #3, ...) is related to the reference point (#20). For each excitation point a transfer function was calculated, e.g. TF_20Z+/I2Z+.
Transfer functions consist of amplitude/phase or real/imaginary part. The 2D graph is the instrument to use, there you can select what you want to display by using the properties from the left side.

To make a bode plot, use two 2D graphs below each other. The above one shows the amplitude (y axis type: LOG), the lower one the phase (y axis type: LIN).

When the amplitude of the transfer function shows a local maximum, and the phase is turning at this point, it usually indicates a resonance. But to avoid an erroneous statement, other parameters have to be checked as well!

4.2. Coherence

The coherence is used to check the correlation between output spectrum and input spectrum. So you can estimate the power transfer between input and output of a linear system. Easily talking, it shows how good the input and output are related to each other.

The amplitude of the coherence can reach max 1.

Low values indicate a weak relation (e.g. when the excitation spectrum has gaps at certain frequencies), values close to 1 show a representative measurement.
That means, when the transfer function shows a peak, but the coherence is low (red circles in the picture below), it must not necessarily be a real resonance. Maybe the measurement has to be repeated (e.g. with a different hammer tip?), or you can additionally look for the MIF parameter, explained below.

Coherence is a Vector channel, and therefore displayed with a 2D graph instrument. The coherence is calculated separately for each point (e.g. Coherence_3Z/1Z, Coherence_4Z/1Z, ...).

4.3. Mode Indicator Function (MIF)

If all parts of a structure are moving sinusoidally with the same frequency (fixed phase relations), this motion is called normal mode. This happens at resonance, or natural frequencies. Depending on the structure, material and bounding conditions there exist a number of mode shapes (e.g. twisting, bending, half-period, full-period movement...).

These are usually found out by finite elements simulation software, or by experimental measurement and analysis.

When the amplitude of the transfer function shows a local maximum, and the phase is turning at this point, it usually indicates a resonance. To be sure, also the Coherence should be checked, as described before. And last, you can look for the MIF (Mode Indicator Function).

A MIF close to 1 indicates a mode shape.

The spikes shown in the picture below are very likely resonance frequencies. Just click on them and check the movement in the geometry instrument. MIF is a Vector channel, and therefore also displayed with a 2D graph instrument. The MIF is calculated over all transfer functions (all points), therefore is only one channel.

4.4. FRF animation

The FRF animation is done by putting sine functions with the amplitudes and phases from the measurement into the geometry model points. The animation is done in one direction (in our example...
Z+). You can animate the structure for a single frequency, which can be chosen in the 2D graph, when setting the Cursor type to "Channel cursor", as shown below. All FRF instruments will follow the channel cursor.

Other than that, the frequency can also be chosen by entering it manually in the FRF geometry properties on the left.

Different parameters like animation speed and amplitude (scale), as well as the visibility (nodes, point numbers, traces, shapes, coordinate system axes) can be changed here.

Here are some of the mode shapes of the snowboard calculated by DEWESoft FRF (you nicely can see bending and twisting).
4.5. Modal circle

Finally, when you are certain the point you are looking at is a resonance, you might want to get it's exact frequency and damping factor. As the FFT can never be that precise (high line resolution needs long calculation time, which is not given when there is a hammer impact), there are some mathematical methods to interpolate.

The method DEWESoft is using, is based on the well-known circle-fit principle. The FFT lines to the right and left side of a peak (so called “neighbour lines”) are drawn by real and imaginary parts in the complex coordinate system. A circle is aligned between them with minimum error to each point and the resonance frequency is approximated.

In the example below we switched the 2D graph “Graph type” property to “histogram” to make the FFT lines visible.
Imagine, we had a sample rate of 2000 Hz, and 1024 FFT lines, resulting in a line resolution of 0.977 Hz. The peak we are looking at is 73.2 Hz. But it could be in the range of 73.2 Hz +/- 0.977 Hz.

We add the Modal circle from the instrument toolbar (see picture above). The 2D graph is again in “cursor” mode, the modal circle instrument will follow. – By clicking on the peak, at first no resonance peak is found.

Then we increase the “Peak search” range from 10 Hz to 20 Hz. The peak is found and by changing the neighbour count you can select how many FFT lines left and right from the peak are taken into calculation. The points should all be aligned nicely on a circle. The red dot shows the calculation result, which should be near the center.

Our final result shows 72.775 Hz and a damping factor of 0.038. With these parameters one can proceed further in simulation software.

4.6. Export of complex data

After the measurement is done the data can be exported to a lot of different file formats, e.g. UNV/UFF, Diadem, Matlab, Excel, Text... The transfer functions (as shown on page 29, chapter 5.1 Transfer function) can be separately exported by Real, Imag, Ampl or Phase part, whatever you prefer.
In MS Excel for example the transfer function data will appear on a sheet called “Single value”. For each transfer function Real/Imag/Ampl/Phase is exported.

**HINT:** If you prefer it differently, data rows and columns can simply be exchanged in MS Excel by copying and using the “Transpose” function from the submenu when pasting.
4.7. Export in UNV / UFF format

The Universal File Format (also known as UFF or UNV format) is very common in modal analysis. Depending on the header it can contain either transfer functions, coherence, geometry, ... or various other data.

The following example shows how to export data recorded by DEWESoft into Vibrant Technologies ME Scope analysis software and how to display it there.

1. First choose the “Universal file format” from the export section and select all your transfer functions (you can use the Filter and type “TF” for simplification). It does not matter if you select Real/Imag/Ampl/Phase part, as the UFF/UNV export follows the standard. This will create a **UNV datafile**.

2. In FRF geometry editor save the structure also in UNV format. This creates the **UNV geometry file**.

3. Start ME Scope and click File → Import → Data block. Select the **UNV datafile**. The transfer functions are already recognized.
4. Then click File → Import → Structure and select the **UNV geometry file**.

5. Now both data and geometry are successfully imported. Let's try to animate it, select Draw → Animate Shapes.
A pop up appears, and we select to match structure and transfer data. Equations are created.

6. Finally you can select a peak on a transfer function and enjoy the animation.

5. Examples (step-by-step)

5.1. Triggered (roving hammer)

As the triggered measurement might be difficult to understand, this section shows how to use the mentioned controls and tools step-by-step. The setup will be done according to page 16, chapter 3.1.2 Triggered, roving hammer.

Let's say we want to analyze this metal sheet structure. At first we define the direction of analysis (orientation up/down, Z axis), then we put it on a soft rubber foam that it can vibrate freely. Of course hanging it with rubber bands from the roof would be better, but would also take more time to wait in each point until the ringing fades out; for now we are fine with it.

Then mark equidistant points, in our case from #1 to #24. The higher the number of points, the more detailed the animation will be. It is also helpful to write numbers next to the points. They should be consistent on 1. structure, in 2. channel setup and 3. FRF geometry in software.
The hammer will move through the points, so in one point an accelerometer has to be mounted. We select point #12.

1. We define the sampling rate with 5000 Hz. Name the hammer and accelerometer in the channel setup and apply the scaling. In our case both are of IEPE type, hammer is measuring force in N, accelerometer acceleration in g. Then go into the channel setup of the hammer.

2. Do a test impact with the hammer on the structure. In the scope preview memorize the max value.
3. In the Modal test setup choose the Triggered FRF type, and use the “roving hammer” option. The trigger level should be set somewhere below the max value of the pre-measurement just done, e.g. 1 N. We will do 3 hits in each point, which are then averaged. The FFT window size is 2048, which gives a good line resolution of 1.22 Hz. - Note, that point #12 is missing on the left side, it will not be hit during measurement, because the accelerometer is mounted there.
4. Now that the points are defined, it is time for drawing the structure. When you switch to measure mode, usually you should have an auto-generated screen called “Modal test”. There the FRF geometry instrument is already shown (x,y,z axis display). From the left side (properties) select “Editor” and add 24 points and their coordinates. You can draw trace lines between them and finally quads (shapes) between them. - Take care that the excitation direction Z is upright and should have the same level for all points of this structure.
5. Now it’s time for a test hit, and finalizing the display arrangement. In measure mode – without storing – you can do a test hit, to fill the displays with signals. Immediately the structure will be animated in the first point. If the auto-generated screen does not look like below, you might have to assign the channels to the instruments. The idea is showing the excitation (blue box) on the left and response (red box) on the right. Use the Scope and FFT signals of the “Current point” subsection in the channel list. They are marked red, because they are only available during measurement. - On the two displays in the lower right section you could use TF and Coherence.
6. To be absolutely sure that your sampling rate and FFT lines settings are correct, you can add two 2D graphics and show the “hammer/Data History” and “acc/Data History”. This is the window used for calculation. Your whole signal should be covered. If the structure keeps on ringing and the response signal is cut, increase the window length (use a higher line resolution or lower sampling rate) or select a lower value for the “Response window decay” parameter. Unfortunately the windowed signals currently cannot be shown.
7. Now we are ready for the measurement. Start storing and do 3 hits on point #1. The scope and FFT graphs will be updated after each hit, so you can visually check for double-hits or “bad” hits and reject them. If you hit a wrong point, you can also reset the whole point. After clicking the “Next point” button, the point number increases, always showing you the current transfer function (e.g. 12-1, 12-2, ...).

The procedure can also be described by a flow chart:
8. When finished, go to Analyze mode. Automatically the last stored file is reloaded. Now you might want to modify the screen for further investigation.

The screen below gives an idea. It shows the first four transfer functions (TF12-1, 12-2, 12-3, 12-4) with amplitude and phase. Below the MIF is shown for easily finding the mode shapes. Just click on the peaks (with the instrument set to Channel cursor mode), on the lower right side the modal circle calculates the exact frequency and damping.
5.2. Free-run

This is a practical example showing free-run FRF. The Analog out of the SIRIUS instrument (FGEN) is followed by an audio amplifier which drives a loudspeaker. On the membran a metal structure (metal beam) is mounted with a force transducer (excitation) and two acceleration sensors (responses).

Here are some of the mode shapes animated.

- 237 Hz
- 409 Hz
- 731 Hz
- 814 Hz
- 1005 Hz
- 1248 Hz
1. In the Analog section we define our force sensor and the two accelerometers. They are all of type IEPE. As we want to analyze our structure up to 1000 Hz, we select a sampling rate of e.g. 5000 Hz.

2. Next we add a FRF module and choose “Use function generator”. A window size of 1024 lines results in a nice resolution of 2.44 Hz. We select a sine sweep from 1 to 1000 Hz. The index numbers 1, 2 and 3 are entered according to the structure, direction is Z+ for all.
3. Also check the Analog out section. Start and stop frequency are already overtaken from the FRF module. We adjust the sweep time (120 seconds) and amplitude (1 V) for now. Startup time and fall time is 0.1 s by default, which prohibits sudden crackles that could result in wide-spectrum noise at beginning and end of measurement.
4. Now we are ready for drawing the structure. Go to measure mode, the screen “Modal test” should be auto generated. Click on the FRF geometry instrument and select “Editor” from the left side. Then add 3 points with the + button, example coordinates as shown below. Then save the structure by clicking on File → Save UNV...
5. Now we are ready for measurement. When you click the store button, the FGEN will start, the AO will sweep from 1 to 1000 Hz. The transfer functions will smoothen from left to right side, here you see a snapshot currently at 357 Hz.
6. Finally we can look at the result. The coherence of both channels related to the excitation looks very nice. The green line (MIF) indicates mode shapes, click on the peaks and the structure will be animated.
6. FAQ

Problem: FRF Geometry instrument cannot be found in the instrument toolbar in Design mode.
Solution: This is a plugin which needs to be registered. Check first if the file “FRFGeometry.vc” is present in your Dewesoft Addons folder (e.g. D:\DEWESoft\V7_1\Addons). Then start DEWESoft and go to Settings → Hardware Setup → Plugins and click → Register plugins. You need administrator rights to do that. Please contact your local IT administrator.

Solution: Please check the impact signal FFT spectrum. If using a hammer with a soft tip, the excitation spectrum is usually small (high damping). Try again with a harder tip.

7. Documentation version history

Revision number: 317

Last modified: Fri 12 Jun 2015, 14:33

<table>
<thead>
<tr>
<th>Version</th>
<th>Date [dd.mm.yyyy]</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>29.05.14</td>
<td>✔ initial revision</td>
</tr>
<tr>
<td>1.1</td>
<td>08.06.15</td>
<td>✔MIMO removed; Triggered, group response removed; ✔ added hint</td>
</tr>
</tbody>
</table>
to 3.2.3 ODS
☑ changed pictures of modal testing force transducer with more suitable one
☑ corrected response exponential window decay lines (20%, 50%, ...)

MODAL TEST AND ANALYSIS
SOLUTION USER MANUAL
About this document

Legend

The following symbols and formats will be used throughout the document.

Important
It gives you important information about the subject.
Please read carefully!

Hint
It gives you a hint or provides additional information about a subject.

Example
Gives you an example of a specific subject.

Warranty information

Notice
The information contained in this document is subject to change without notice.

Note:
Dewesoft d.o.o. shall not be liable for any errors contained in this document. Dewesoft MAKES NO WARRANTIES OF ANY KIND WITH REGARD TO THIS DOCUMENT, WHETHER EXPRESS OR IMPLIED. DEWESOFT SPECIFICALLY DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Dewesoft shall not be liable for any direct, indirect, special, incidental, or consequential damages, whether based on contract, tort, or any other legal theory, in connection with the furnishing of this document or the use of the information in this document.

The copy of the specific warranty terms applicable to your Dewesoft product and replacement parts can be obtained from your local sales and service office. To find a local dealer for your country, please visit https://dewesoft.com/support/distributors.

Calibration
Every instrument needs to be calibrated at regular intervals. The standard norm across nearly every industry is annual calibration. Before your Dewesoft data acquisition system is delivered, it is calibrated. Detailed calibration reports for your Dewesoft system can be requested. We retain them for at least one year, after system delivery.

Support
Dewesoft has a team of people ready to assist you if you have any questions or any technical difficulties regarding the system. For any support please contact your local distributor first or Dewesoft directly.
Dewesoft d.o.o.
Gabrsko 11a
1420 Trbovlje Slovenia

Europe Tel.: +386 356 25 300
Web: http://www.dewesoft.com
Email: Support@dewesoft.com
The telephone hotline is available Monday to Friday from 07:00 to 16:00 CET (GMT +1:00)

Service/repair
The team of Dewesoft also performs any kinds of repairs to your system to assure a safe and proper operation in the future. For information regarding service and repairs please contact your local distributor first or Dewesoft directly on https://dewesoft.com/support/rma-service.

Restricted Rights
Use Slovenian law for duplication or disclosure. Dewesoft d.o.o. Gabrsko 11a, 1420 Trbovlje, Slovenia / Europe.

Printing History

Copyright
Copyright © 2015-2019 Dewesoft d.o.o. This document contains information which is protected by copyright. All rights are reserved. Reproduction, adaptation, or translation without prior written permission is prohibited, except as allowed under the copyright laws. All trademarks and registered trademarks are acknowledged to be the property of their owners.

Trademarks
We take pride in our products and we take care that all key products and technologies are registered as trademarks all over the world. The Dewesoft name is a registered trademark. Product families (KRYPTON, SIRIUS, DSI, DS-NET) and technologies (DualCoreADC, SuperCounter, GrandView) are registered trademarks as well. When used as the logo or as part of any graphic material, the registered trademark sign is used as a part of the logo. When used in text representing the company, product or technology name, the ® sign is not used. The Dewesoft triangle logo is a registered trademark but the ® sign is not used in the visual representation of the triangle logo.

Safety instructions
Your safety is our primary concern! Please be safe!

Safety symbols in the manual
MODAL TEST AND ANALYSIS
SOLUTION USER MANUAL

Calls attention to a procedure, practice, or condition that could cause the body injury or death

**Caution**
Calls attention to a procedure, practice, or condition that could possibly cause damage to equipment or permanent loss of data.

**General Safety Instructions**

**Warning**
The following general safety precautions must be observed during all phases of operation, service, and repair of this product. Failure to comply with these precautions or with specific warnings elsewhere in this manual violates safety standards of design, manufacture, and intended use of the product. Dewesoft GmbH assumes no liability for the customer’s failure to comply with these requirements.

All accessories shown in this document are available as an option and will not be shipped as standard parts.

**Environmental Considerations**
Information about the environmental impact of the product.

**Product End-of-Life Handling**
Observe the following guidelines when recycling a Dewesoft system:

**System and Components Recycling**
Production of these components required the extraction and use of natural resources. The substances contained in the system could be harmful to your health and to the environment if the system is improperly handled at its end of life! Please recycle this product in an appropriate way to avoid unnecessary pollution of the environment and to keep natural resources.

This symbol indicates that this system complies with the European Union’s requirements according to Directive 2002/96/EC on waste electrical and electronic equipment (WEEE). Please find further information about recycling on the Dewesoft web site www.dewesoft.com

Restriction of Hazardous Substances
This product has been classified as Monitoring and Control equipment and is outside the scope of the 2002/95/EC RoHS Directive. However, we take care of our environment and the product is lead-free.

**General safety and hazard warnings for all Dewesoft systems**
Safety of the operator and the unit depend on following these rules.
- Use this system under the terms of the specifications only to avoid any possible danger.
- Read your manual before operating the system.
- Observe local laws when using the instrument.
- DO NOT touch internal wiring!
- DO NOT use higher supply voltage than specified!
- Use only original plugs and cables for harnessing.
- You may not connect higher voltages than rated to any connectors.
- The power cable and connector serve as Power-Breaker. The cable must not exceed 3 meters, the disconnect function must be possible without tools.
- Maintenance must be executed by qualified staff only.
- During the use of the system, it might be possible to access other parts of a more comprehensive system. Please read and follow the safety instructions provided in the manuals of all other components regarding warning and security advice for using the system.
- With this product, only use the power cable delivered or defined for the host country.
- DO NOT connect or disconnect sensors, probes or test leads, as these parts are connected to a voltage supply unit.
- Ground the equipment: For Safety Class 1 equipment (equipment having a protective earth terminal), a non-interruptible safety earth ground must be provided from the mains power source to the product input wiring terminals.
- Please note the characteristics and indicators on the system to avoid fire or electric shocks. Before connecting the system, please read the corresponding specifications in the product manual carefully.
- The inputs must not, unless otherwise noted (CATx identification), be connected to the main circuit of category II, III and IV.
- The power cord separates the system from the power supply. Do not block the power cord, since it has to be accessible for the users.
- DO NOT use the system if equipment covers or shields are removed.
- If you assume the system is damaged, get it examined by authorized personnel only.
- Adverse environmental conditions are Moisture or high humidity Dust, flammable gases, fumes or dissolver Thunderstorm or thunderstorm conditions (except assembly PNA) Electrostatic fields, etc.
- The measurement category can be adjusted depending on module configuration.
- Any other use than described above may damage your system and is attended with dangers like short-circuiting, fire or electric shocks.
- The whole system must not be changed, rebuilt or opened.
- DO NOT operate damaged equipment: Whenever it is possible that the safety protection features built into this product have been impaired, either through physical damage, excessive moisture, or any other reason, REMOVE POWER and do not use the product until the safe operation can be verified by service-trained personnel. If necessary, return the product to Dewesoft sales and service office for service and repair to ensure that safety features are maintained.
- If you assume a more riskless use is not provided anymore, the system has to be rendered inoperative and should be protected against inadvertent operation. It is assumed that a more riskless operation is not possible anymore if the system is damaged obviously or causes strange noises. The system does not work anymore. The system has been exposed to long storage in adverse environments. The system has been exposed to heavy shipment strain.
- Warranty void if damages caused by disregarding this manual. For consequential damages, NO liability will be assumed!
- Warranty void if damage to property or persons caused by improper use or disregarding the safety instructions.
- Unauthorized changing or rebuilding the system is prohibited due to safety and permission reasons (CE).
• Be careful with voltages >25 VAC or >35 VDC! These voltages are already high enough in order to get a perilous electric shock by touching the wiring.
• The product heats during operation. Make sure there is adequate ventilation. Ventilation slots must not be covered!
• Only fuses of the specified type and nominal current may be used. The use of patched fuses is prohibited.
• Prevent using metal bare wires! Risk of short circuit and fire hazard!
• DO NOT use the system before, during or shortly after a thunderstorm (risk of lightning and high energy over-voltage). An advanced range of application under certain conditions is allowed with therefore designed products only. For details please refer to the specifications.
• Make sure that your hands, shoes, clothes, the floor, the system or measuring leads, integrated circuits and so on, are dry.
• DO NOT use the system in rooms with flammable gases, fumes or dust or in adverse environmental conditions.
• Avoid operation in the immediate vicinity of high magnetic or electromagnetic fields, transmitting antennas or high-frequency generators, for exact values please refer to enclosed specifications.
• Use measurement leads or measurement accessories aligned with the specification of the system only. Fire hazard in case of overload!
• Do not switch on the system after transporting it from a cold into a warm room and vice versa. The thereby created condensation may damage your system. Acclimatise the system unpowered to room temperature.
• Do not disassemble the system! There is a high risk of getting a perilous electric shock. Capacitors still might be charged, even if the system has been removed from the power supply.
• The electrical installations and equipment in industrial facilities must be observed by the security regulations and insurance institutions.
• The use of the measuring system in schools and other training facilities must be observed by skilled personnel.
• The measuring systems are not designed for use in humans and animals.
• Please contact a professional if you have doubts about the method of operation, safety or the connection of the system.
• Please be careful with the product. Shocks, hits and dropping it from already- lower level may damage your system.
• Please also consider the detailed technical reference manual as well as the security advice of the connected systems.
• This product has left the factory in safety-related flawlessness and in proper condition. In order to maintain this condition and guarantee safety use, the user has to consider the security advice and warnings in this manual.

EN 61326-3-1:2008
IEC 61326-1 applies to this part of IEC 61326 but is limited to systems and equipment for industrial applications intended to perform safety functions as defined in IEC 61508 with SIL 1-3.

The electromagnetic environments encompassed by this product family standard are industrial, both indoor and outdoor, as described for industrial locations in IEC 61000-6-2 or defined in 3.7 of IEC 61326-1.

Equipment and systems intended for use in other electromagnetic environments, for example, in the process industry or in environments with potentially explosive atmospheres, are excluded from the scope of this product family standard, IEC 61326-3-1.
Devices and systems according to IEC 61508 or IEC 61511 which are considered as “operationally well-tried”, are excluded from the scope of IEC 61326-3-1.

Fire-alarm and safety-alarm systems, intended for the protection of buildings, are excluded from the scope of IEC 61326-3-1.